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2. INTRODUCTION 

Introducing Spark 3™, the entry-level board with top-tier features. Sporting easy configuration, out-of-the-box 

motion sensitivity, and a robust true 16bit DAC, this board has motion and audio found only on top-level boards 

but at an entry-level price. And with 3 fonts and RGB color-mixing, it’s an all-in-one hilt allowing for light, dark, and 

grey warriors all in one hilt. Finally, enjoy some of your favorite tunes using Saber Tracks™, and even turn on the 

blade with pulsing effect while the music is playing. 

2.1. NEW IN SPARK 3™  

There are many improvements in Spark 3™ from the Spark 2™ platform. The following are the main improvements: 

HARDWARE 

 16bit off-CPU DAC for crystal-clear audio from all 8ohm speakers. 

 Motion Sense V2 ported from Igniter 3™, most accurate motion detection in a production board. 

FIRWMARE 

 Error LED as part of bootstrapper and main app. 

o Blinks for SD card error, config file errors, and wav errors 

o Also blinks for warnings such as missing wavs (see <> below) 

2.2. NEW IN SPARK 3™ R2  

The following features have been added to the S3-R2 release: 

 EzClash™ improvements. By holding the aux button before performing the clash, the effect will directly go 

into the lockup, skipping the clash altogether. If you do a clash and hit the aux, it will behave as before. 

This ensures the lockup color will be the actual clash color when starting with holding the main button for 

single button installs. 

 Pixel Support. No longer are you limited by certain brands of pixel strings; now Spark 3™ supports all kinds 

of strings on the market, including the notoriously finicky ALotive. 

 RGBW Pixel Strings! Related to the above addition, Spark 3™ R2 now supports RGBW SK6812 pixel strings. 

These can be purchased from BTF Lighting on Amazon among other suppliers. 

 C4 is now available for use! This means that RGBA or RGBW high-power LEDs can be used with Spark 3™ 

R2, as well as other accessories like rumble motors. 

2.3. NEW IN SPARK 3™ R3  

S3-R3 comes with the new RealSwing™ feature! The next iteration in the MotionSense V2 engine, this system 

tracks motion in real time, playing the appropriate swing bank and appropriate pitch and volumes as well. This 

allows for precise swings that match the motion at any speed. Further, all swing sounds are based off the same 

swing files, so it is a more matched sound than smoothswing can provide. 

2.4. NEW IN SPARK 3™ R4 

Spark 3 R4 comes with some exciting new improvements from the previous releases! 
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2.4.1. DRAG MODE 

Spark 3™ R4 now has a new drag mode. When holding the saber down and holding the aux button, only the tip 

portion of the blade will perform the clash effect, for a neat “drag” effect. The number of pixels that lights up can 

be set in the config with the DRAG COUNT NECEditor parameter. Normal lockup will occur with the blade straight 

out, up, and angled down. With the parameter set to zero (0), the normal lockup will occur even when the blade is 

facing down and the feature will be disabled. 

This feature ONLY works when using a pixel blade. 

2.4.2. IGNITER FEATURES 

The following features have been ported from Igniter: 

Saber Cinema™ - Use the saber with lights and sounds while the music is playing! Now sound effects and all 

lighting effects occur when the saber is in use. 

ClashShade, BlastShade, and BladeShade – Allows for variance in the color-sets so that each effect or blade color 

varies with each use. Allows a more organic color experience, or with high values even random colors! 

3. GETTING STARTED 

3.1. IMPORTANT NOTES 

PLEASE READ THIS SUBSECTION CAREFULLY AS FAILURE TO DO SO COULD CAUSE DAMAGE TO THE SPARK™ 

BOARD. 

3.1.1. 3.7v Power Supply 

Spark 3™ is designed around a 3.7v power supply input. In general, the best way to run a Spark 3™ is to hook up a 

single 3.7v battery to the VBATT+ and VBATT-/GND pads. 

NEVER HOOK A 7.4V BATTERY DIRECTLY TO A SPARK 3™ UNDER ANY CIRCUMSTANCES, OR YOU WILL 

DESTROY THE BOARD. 

NEVER REVERSE THE POLARITY OF VBATT+ AND VBATT-/GND. IF USING A CONNECTOR FOR THE 

BATTERY, MAKE SURE TO USE ONE THAT ONLY CLIPS IN ONE WAY TO PREVENT DAMAGING THE 

BOARD BY HOOKING THE POWER IN REVERSE. 

3.1.2. BATTERY PROTECTION 

Only use li-ion batteries that have a built-in protection circuit. NEVER USE UNPROTECTED CELLS AS THIS CAN 

CAUSE DAMAGE TO THE BATTERY AND/OR SPARK 3™. IMR batteries are okay but since they are not 

protected they can allow large amounts of power to the board and do not act like a fuse when there is a wiring 

issue, so for beginners it is recommended to use the standard Li-ion with the protection circuit. 
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3.1.3. BATTERY BRANDS 

Because only one battery is being used, it is very important that a quality battery is selected to get the best 

experience from Spark 3™. From internal testing, it is determined that the best batteries are ones with a 10amp 

protection circuit or higher. Specifically, the following batteries meet this criteria: 

 KeepPower 18650 3120mAh 15amp PCB 

 KeepPower 18650 3400mAh 10amp PCB 

 Solo’s Hold 18650 15 amp PCB 

 Solo’s Hold 18650 10 amp PCB 

When using a pixel string blade, or a cross-guard setup a 10amp PCB battery MUST be used. Failure to do this will 

lead to the board shutting down unexpectedly during effects. 

3.1.4. BATTERY SIZE 

The best battery to use is an 18650, space allowing. If that cannot be used, then an 18500, 17650, 16650, or 17500 

should be used, in that order. 14xxx batteries and 18350 batteries are not recommended due to their shorter life, 

and because those batteries may not be able to output enough power to run 4 die of a High Brightness LED 

(HBLED). 

3.1.5. LED CHOICES 

When using Spark 3™ with a 3.7v power source the LEDEngin LEDs will not work well. This is because LEDEngin’s 

green and blue dies require a forward voltage of 4.0v for maximum brightness. Thus it is highly recommended to 

use the NECree RGB Red/Green/Royal Blue LED sold here at Naigon’s Electronic Creations. 

http://saberigniter.com/NECreeRGB.aspx 

The NECree RGB produces the brightest, most even blade for an in-hilt LED, but it also is pre-wired for 3.7v with a 

diode built-in for the red, so no external resistors are needed. The standard TriCrees work as well but will require a 

resistor for red, and a bit more wiring to connect all the positives together. 

3.1.6. PIXEL STRING CHOICES 

Not all pixel strings are created equal. There are two sizes 5050 and 3535, with the former having better density, 

but the latter are thinner and fit in a blade better with less vertical shadowing. The IntelliBlade™ was designed to 

be the best of both worlds and is the best choice, but I’ve put that product on hold due to the cost to manufacture 

and fragility of shipping making the product not worth the investment. 

When purchasing a strip, make sure it has at least 144 LED/M; anything less dense will have way too much corn-

cobbing, with blotches of brightness up the blade. 

The best strips currently available to use are the NeoPixel strings from Adafruit: 

 5050 - https://www.adafruit.com/product/1507 

 3535 (Skinny) - https://www.adafruit.com/product/2969 

http://saberigniter.com/NECreeRGB.aspx
https://www.adafruit.com/product/1507
https://www.adafruit.com/product/2969
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That being said, Adafruit’s strips are really over-priced compared to the competition. Sparkfun has very similar 

strips that are much more affordable, but still very high quality. 

 3535 (Skinny) - https://www.sparkfun.com/products/14732 

 5050 RGBW - https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-

waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1 

Naigon’s Electronic Creations does NOT recommend the Alotive brand strips from Amazon, as they are a cheaper 

LED and seem to cause addition line noise from internal testing, though these strips do now work with our 

products. 

3.2. SPARK 3 LAYOUT 

Before getting started, it is important to familiarize yourself with the layout of Spark 3™, TruDrive™ and all of the 

pads on the board. This will help in wiring up the board for use in a saber. 

The following two diagrams show the important components of Spark 3™, with an accompanying table describing 

what each component does. 

 

 
Figure 1 – Important components on the back of Spark 3™. 

https://www.sparkfun.com/products/14732
https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1
https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1
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Name Label Description 

1. Micro SD card 
holder 

NA Holds the Spark 3™ SD card. Ensure the card is fully inserted 
before applying power to Spark 3™. 

2. TruDrive™ 
board 

LED DRIVER PCB Driving board that can power two high-power LEDs from Spark 
3™. On Spark 3™ only the first three Pads are available. 

3. Battery +/- 
pads 

BAT+, BAT- Hook power and ground from a 3.7v Li-ion pack here. 

4. Speaker pads SPKR Hook a 1.5-2.0w, 8ohm speaker here. 

5. Accent 
Common + 

VLED+ Used to power all three of the accent LEDs. Optionally, 
additional static LEDs can be powered from this pad. The 
output is 3.3v, and it is rated at 200mA. 

6. Accent LED 
pads 

1,2,3 Each pad can hold one 20mA accent LED. These LEDs will be 
sequenced by the chosen pattern. 

7. LED connect 
pads 

1,2,3,4 Pads that hook the TruDrive™ board to the Spark 3™ main 
board. Pad #4 is not used. 

8. Color Pads C1-, C2-, C3-, C4- Hook the main LED and flash LED cathodes to these pads. 

9. Switch Pads MAIN, AUX Pads for the switches. MAIN can be a momentary or latching, 
aux must be a momentary. Make sure to select the correct 
type of switch for MAIN in the Config Editor. 

Table 1– Description of each component. 

3.3. TRUDRIVE™ SEPARATION  

Spark 3™ will come by default with the TruDrive™ attached to the main board. If it is desired to have the TruDrive™ 

separate from the main board for the install, then you can detach the two boards. 

To separate them, place a mouse pad at the edge of a table, and place Spark 3™ on the pad with the seam where 

TruDrive™ meets Spark right at the edge of the table, so that the entire TruDrive™ is off the table and the entire 

Spark™ is on the mouse pad. Then with one palm press and hold Spark™ to the pad, and gently use your other 

hand to press the other board until it starts to snap. Then simply wiggle the TruDrive™ back and forth until it 

comes free. 

It is important to note that once the board has been removed it cannot go back on; plan accordingly before 

separating the boards. 

4. WIRING DIAGRAMS 

The following diagrams are the most common to get your board up and running. 

Note: It is very important that the correct resistor be used between the negative pad of the LED and C1-, C2-, and 

C3- to prevent burning out the LED for warm color LEDs. For Rebel LEDs if a red, red-orange or amber LED is used, 

then a 1ohm 1watt resister is needed. For any other Rebel colors a resistor is not needed. The STTH2L06 diode can 

be used in place of the resistor and it is a slightly smaller part. 

4.1. BASIC WIRING 

This is the most basic wiring that is possible to get the board up and running. It is great for testing your Spark 3™ 

on the bench, or if you are doing a simple install into a saber that will have a removable battery. 
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Figure 2 – Basic wiring for Spark 3™. This will drive a single main LED and would require a removable battery for charging. Note that a 

resistor between the blue wire and C1- of TruDrive™ would be needed if the LED is red, amber, or red-orange. 

4.2. FLASH WIRING 

Wiring a basic setup to have a TriCree LED with two die of one color and a third die for a flash color is a popular 

choice for Spark 3™. This setup allows for a bright single-color blade while still allowing for an effect/aux color for 

blast and clash/lockup effects. The wiring diagram below shows how to utilize that setup. 

The preferred LED to use for this setup is the TriCree, as it has an optic made specifically for this configuration, and 

it has a great balance of brightness with good efficiency, so it doesn’t waste too much power. It also produces a 

very even blade when diffused and sanded. The X2/X4 previously recommended is no longer preferred as it’s optic 

doesn’t allow enough of the brightness down the tube evenly. 
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Figure 3 – Wiring a Spark3™ for a main blade and a flash color. Note that the colors can be mixed, so it is possible to have a mix of the two, 

or utilize the flash color as the main blade color for one of the three fonts. R1 is needed if the die is Red, Red-orange, or amber. 

For this setup with the bridging shown in <>, it is recommended to set c1Color and c2Color, c1Clsh and c2Clsh, and 

c1Blst and c2Blast to the same values for a given font to ensure that both LEDs of that same color are enabled. 

4.3. RGB WIRING 

Spark 3™ supports full RGB color mixing. This diagram shows how to hook up an R/G/rB die for the ultimate color 

mixing. The recommended LED to use by far is Naigon’s Electronic Creations own NECree RGrB v2. It utilizes the 

highest binned XP-E2 Cree dies, in a common-positive wiring with the STTH2L06 diode already installed, so NO 

EXTERNAL RESISTORS ARE REQUIRED for the LED. 
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Figure 4 – RGrB wiring utilizing the NECree RGB v2 LED. Note that no external resistors are needed with this LED. 

4.4. SINGLE AV SWITCH WIRING 

Spark 3™ can be controlled with a single switch. When using one switch some find an AV switch to be beneficial as 

it incorporates an accent LED and switch into one hole. 

The following diagram shows the same RGB wiring with the NECree RGrB LED, but using an AV switch instead of 

two tactile switches. It is important to note that a single tactile works fine as well, but it does need to be a 

momentary switch for the main button. 

Also, when using this wiring configuration, ensure that the Button Layout dropdown is set to either “One Button” 

or “One Button w/ Motion” in the NEC Editor. 
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Figure 5 – Single AV switch wiring with the NECree RGrB LED. It is difficult to see in the picture, but the yellow wire to the switch is hooked to 

the pad labeled “+”, purple to “-“, and the two green don’t matter. 

4.5. RGBA/RGBW WIRING 

With Spark 3™ R2, a fourth die can be utilized for even more flash effects, and a bit more vivid (and efficiently 

mixed) colors. The following diagram shows this wiring for a CREE XML RGBW LED, but a quad-rebel or a quad cree 

works as well. In general it is recommend to stick with a standard RGB setup for simplicity, but for folks that really 

want to do a lot of white/silver colors this may be a choice. 
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Figure 6 – Cree XML RGBW LED. This allows having a white die, which makes some colors mix more efficiently and a bit brighter clash effects 

for some colors. Similar wiring for a quad rebel or quad cree would work as well. 

4.6. COLOR MATCHING CRYSTAL MATCHING 

With the advent of color mixing many people are wanting a blade matching crystal chamber to go along with their 

build. If you want to experience this thrill, then look no further! The following diagram shows how to get this LED 

wired and working. 

It is important to note that this wiring is applicable to in-hilt LED setups only; when doing a blade matching crystal 

for a pixel string, an individual pixel must be used. 
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Figure 7 - Wiring with an RGB crystal chamber. This will have an RGB led that matches the blade color and pulses with the blade. Note that 

all three pins of the REB LED have a resistor since power is coming from the battery. I recommend a 22-33ohm for R1, and a 1ohm each for 

R2. 

4.7. RUMBLE MOTOR WIRING 

When not using a 4th die the C4 pin can be used to run an accessory, such as a rumble motor or another special 

accent LED. 

The following diagram shows the use of a low power (3.3v) shaft-less motor that can be purchased from Pololu 

here. If using something that requires more voltage than 3.3v, the power could be drawn directly from the battery 

instead of the VLED+ pin. 

http://www.pololu.com/catalog/product/1636


Page | 16 

 

 
Figure 8 – Diagram with a small shaft-less motor running of the C4- pad. For accessories that require more voltage/amperage, direct battery 

power can also be used. 

4.8. CROSS-SABER WIRING 

For those that want to mimic the saber with two side quillion or cross-guard blades that have the delayed 

extension, the following wiring diagram is provided. This supports a saber where all three blades are the same 

color, with a secondary flash color for either the main blade or all blades. 

I’ve provided the wiring for a TriCree though any other LED would be similar. If using a TriCree I recommend only 

hooking up two of the three die for the side LEDs to prevent battery drain and to ensure that a single channel does 

not get too hot. 

Note that when using Red or Amber die resistors would be needed between the die and the appropriate Cn- pad. 
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Figure 9 – Wiring for the Cross-Saber feature. This is for a single color blade and side guards, but allows for a FOC color on the main blade. 

Note that 4 resistors or STTH2L06 diodes would be needed for a Red/amber color, labeled as R1-R4 in the diagram. This wiring also utilizes a 

single AV switch, so the configuration would need to reflect that (one button or one button with motion). Finally, c1Color and c2Color could 

be set independently if the die off C2- was a different color to allow for the flash-clash effects. 

After wiring this, make sure that not only Cross-Saber is enabled in the master section, but each font where it is 

desired for the side LEDs to be on will also need C4PERCENT set to 95 in the master, and then C4COLOR set to a 

non-zero value for each effect where the secondary blade(s) should be on. If you want a simple static blade then 

just set all three c3 values C4COLOR, C4BLST, C4FLSH to 255. However, if you want them to only come on for flash 

effects, set C4COLOR to 0, but the rest to 255. You can also turn them down some to something like 155 to save 

some power. For C1COLOR and C2COLOR, and C3COLOR, they could be set the same if the TriCree is all red, or set 

independently to have c2Color off for the main blade and enabled for the other effects, allowing the main blade to 

have a flash-clash color. 

4.9. X-SABER WIRING 

When using the external XDrive, it is possible to have a cross-guard saber with full color mixing on the main blade 

and the two quillions. This specific example uses 3 NECree RGrB LEDs, but any RGB LED could be used. 

Note that with this configuration it is recommended to use a 26650 since the runtime drain for this setup is quite 

high; if that battery cannot be used at least use the KeepPower 18650 3120mAh as it has a 15amp PCB and does a 

bit better with the higher amperage draw. 
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Figure 10 - Wiring with the XDrive for the X-Saber feature. If TriCrees are used then 3 reisstors/STTH2L06’s would be needed for the red die. 

For this wiring, the config will need to be setup just like for the single-color side blades. See 4.8 CROSS-SABER 

WIRING on how to do that. Note that C4COLOR will determine if the side blades are on/off, but C1COLOR, 

C2COLOR, and C3COLOR set the actual colors for both the main and side blades. 

4.10. PIXEL STRING WIRING 

Spark 3™ fully supports Pixel string blades, aka WS2812B, out of the box! All that is needed is a separate SD card 

with the string blade /dat and /appNN files. These strings are not only super bright, but they also support 

Extension and Retraction Flow, allowing for super-realistic growing and shrinking blades, and Impact Blast™, the 

ability to replicate bolts hitting the blade in defined spots. 

The Pixel strings are quite easy to work with as there are only 3 wires coming out of each strip. When using the 

5mm LEDs, these 3 wires are exactly what will be needed. When using the 144 led/meter strips, the two 

connections will need to be run in parallel for each strip to light in the same way as the others. 

This connector being used is the flat one from TCSS which uses POGO pins. 

NeoPixel blades can be built from the 144 led/meter strips: 
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https://www.adafruit.com/products/2969 

or by building a blade from 5mm NeoPixel individual straw-hat LEDs: 

https://www.sparkfun.com/products/12999 

To see how awesome these look, check out the release video here: 

https://www.youtube.com/watch?v=nP17IWlQS6M 

IMPORTANT – Because the Pixels use a completely different driver system, the #2-#4 pins are used as simple 

grounds when using a string blade. This means that if you want to wire a blade matching crystal chamber, you will 

need to use a NeoPixel individual LED wired in parallel with the main blade. Rumble motors are thus not 

supported. 

 
Figure 11 – Wiring a back to back style WS2812 blade with two parallel strips. It is also possible to do three strips back to back, which 

reduces the vertical shadowing of the blade, but increases the amperage draw. Note that a 0603 resistor on the blade side connector 

between 270 to 400ohm should be used. 

 

4.11. FULL WIRING 

This diagram shows how to wire a recharge port along with accent LEDs and the NECree RGB v2 LED, allowing all 

the features of Spark 3™ to be utilized. The recharge port also acts as a kill key, where pushing a kill plug into the 

port will stop power from getting to the board.  

https://www.adafruit.com/products/2969
https://www.sparkfun.com/products/12999
https://www.youtube.com/watch?v=nP17IWlQS6M
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Figure 12 – Full wiring using all accent LEDs and a recharge port/kill key combo. This wiring will allow all features of Spark 3™ to be 

experienced, including full RGrB color mixing. 

5. CONFIGURATION EDITING 

Once Spark 3™ has been wired according to the wiring above then it will work immediately with the default 

configuration. However, changing the fonts and effects is completely possible and encouraged by using the NEC 

Editor. The NEC Editor is the new replacement for the old Config Editors; the NEC Editor is great in that it can edit 

every board, and can also work on both Windows and Mac! 

5.1. INSTALLATION 

On Mac, unzip the file. Double click the DMG. When the NEC Editor pops up, just drag it over to the APP folder, and 

this will install the app. I’ve found that on some versions of Mac OS it is necessary to grab near the word NEC 

Editor as opposed to the board icon when dragging; trying to grab the icon I results in no action being taken. 
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Figure 13 - Installing the NEC Editor on Mac. Make sure to grab the "NECEditor" icon near the text. 

On Windows, unzip the file, or just double click to open the zip. Double click the installer to start the install 

process. It may be necessary to click OK on the warning that changes are going to be made by your computer. 

 

Figure 14 - In Windows, double click the installer exe to bring up the install wizard. 
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5.2. COPY FILES TO YOUR MACHINE 

Before opening NEC Editor you will need to copy the files you want to edit from the micro SD card to your local 

computer. First, insert your micro SD card into your computer using your SD card reader. If you do not currently 

have one, I recommend this cheap one off eBay: Micro SD card. 

Then, open a new window and find a place to put a new Spark directory. In this example the Spark directory will be 

placed right on the root c:\ drive. Create a new directory and name it “Spark”. Then, inside that directory, create 

another folder with the name of your saber. In this example, “Saber1” will be used. 

Now, with both the Saber1 empty directory open and the micro SD card opened, select all the files from the micro 

SD card, and drag them into the Saber1 directory. When done, all the files should be copied to your hard-drive as 

shown below. 

 

Figure 15 – After creating a new directory called “c:\Spark\Saber1”, the files are copied from the micro SD card (on the right) to the new 

Saber1 folder (on the left). From here edits can be made to the files from the config editor. 

 

5.3. LAUNCHING THE APPLICATION 

To launch the NEC Editor in Mac, you can use spotlight search or launch, and then type “NEC” to filter to the NEC 

Editor. Once it appears, double-click to launch. 

On Windows, double click the desktop items, or use the program menu to find NEC Editor, and click it. 

http://www.ebay.com/itm/New-USB-2-0-SD-Micro-SD-TF-T-Flash-Memory-Card-Reader-/160575697242?pt=US_Memory_Card_Readers_Adapters&hash=item25630eb15a
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Once launched you should see the program as below: 

 

Figure 16 – NEC Editor launched after installation. 

You can then go to File->Open, and the open dialogue will appear. Navigate to the “c:\Spark\Saber1” folder and 

then go into one of the fonts to edit. When you see the SCONFIG.INI appear in the window, double click it or 

select it and click open to load the program for editing this font. Note that you must select the SCONFIG.INI file; it 

is not a folder selection. 
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Figure 17 – Navigate to “c:\Spark\Saber1” in the window, and then select either font1, font2 or font3 to edit. When you see sconfig.ini, 

double click it to open editing for the font. 

5.4. CHANGING SOUNDFONTS 

Changing sound fonts was never easier than with the new NEC Editor. With the auto-sync of the app open you can 

switch fonts easily even when directly editing a font in the NEC Editor. You also swap the font before opening it for 

the first time. 

To copy a new sound font, first go to the font that you want to change. In this example it will be 

“c:\SparkColor\Saber1\font1”.  Navigate to that directory in explorer and then select both of the .wav files 

(font.wav and multi.wav), and all the wav folders. I find the easiest way to do that is to select all (edit->select all or 

ctrl+A), then hold control and click the config.ini and accent.ini files (along with the backup folder if already 

present) to unselect those files. Then you can delete the original files to the recycle bin. Make sure you have a 

separate backup of these waves before doing this. 
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Figure 18 – Delete the existing font by selecting all the files, then hold control and uncheck ‘accent.ini’, ‘config.ini’, and ‘backup’ if it is 

present. Then the selected wav files can be deleted or cut and pasted into a backup location. 

After the wav files are removed and all that is left is the config files and backup folder, you can copy in all the new 

wav files from a new font. You can find these from online saber sound websites, and there are some free ones 

available from my website as well: http://SaberIgniter.com/fonts.aspx. 

Once the files are copied, then either open the font in the NEC Editor, or if the NEC Editor was already opened to 

this font, simply switch back to the NEC Editor, and it will auto-sync the font numbers from disk, and it will auto-

convert them to 22050Hz, mono with appropriate headers! 

http://saberigniter.com/fonts.aspx
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Figure 19 – After making changes on the disk simply switch back to the app and it will sync with the correct numbers. In this case the 

clsh08.wav was deleted, but this will even work for swapping out an entire font. 

5.5. EDITING SETTINGS 

With the file open, you have access to all the configuration settings from spark. Unlike Igniter™ which has a bunch 

of sliders for individual parameters, Spark 3™ has simple dropdown values that represent high-level pre-configured 

features. This makes editing a breeze and removes any confusion with what certain settings control. 

The following sections go over each tab of the config editor, and give a description on how the settings are used. 

5.5.1. MASTER 

The master tab in the NEC Editor contains global settings that generally apply to every font, not just the current 

loaded font. The following settings are utilized in the master tab for Spark 3™: 
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Figure 20 – Screen shot of the master tab. 

C1PERCENT, C2PERCENT, C3PERCENT – drive settings that control the percentage of the LED. Use these to turn 

down the overall brightness of a die regardless of what color value is set. For example, setting C3PERCENT to 185 

with cross guard will always turn down the side blades even if their color is set to 255, allowing some power saving 

for those short blades. 

CROSSGUARD – Enable the cross-guard functionality, delaying the extension of the LEDs connected to C3-. 

PIXEL TYPE sets which specific pixel protocol should be used for the blade. When purchasing pixel strips, it should 

be noted by the manufacturer on which setting to choose. Choose one of the RGR options if the red and green are 

reversed in color from the NEC Editor. When using an in-hilt LED, this setting is not used. 

BUTTON LAYOUT (BTYPE) – Indicates the type of button solution utilized. Choices are “Two Buttons”, “One 

Button”, and “One Button w/ motion”. The latter allows all features of the board to be used with only a single 

momentary switch. 

MBUTTON – Sets the type of button for the main switch, either momentary or latching. Not applicapable if the 

button type is set to “One Button” or “One Button w/ Motion” as either of those require a momentary switch.  



Page | 28 

 

SWAP BUTTONS (BSWAP) – Set this to swap the location of the main and aux buttons. Only recommended if both 

are momentary. 

USE BOOT SOUND (BOOT) – Indicates if when the saber starts it should play the boot sound, or the font.wav from 

the first font. 

LOWPWR – Time in seconds that the saber is in idle before it goes into low power mode, cutting the accent LEDs 

and the motion. A single aux press (or main button tap for a single button) will wake the board. Set to zero (0) to 

never enter low power. 

NSTRP – Applicable only when using a WS2812 (NeoPixel) blade. This defines the length of a single strip of the 

blade – for example, when using a triangular prism blade, if the lengths of each strip are 144, 145, and 144, then 

choose 145 or the side with the maximum length. Currently the maximum number supported is 255. 

After making all the edits desired, to go File->Save in the program to save the new configuration settings. Repeat 

for any other fonts where the effects are going to be configured before transferring the files back to the micro SD 

card. 

5.5.2. MOTION 

This section contains the motion sensitivity settings. Each setting is described below. 
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Figure 21 – Screenshot of the Motion tab. 

LSWGTHRESH – Swing threshold to determine the sensitivity that means a low swing is occurring. These are the 

long, drawn out swings that will be played at a bit quieter volumes. Zero (0) means very sensitive, 255 means it will 

be quite a bit of force before the low swing is triggered. 

SWNGTHRESH – Swing threshold to determine the swing sensitivity. Zero (0) means very sensitive, 255 means it 

takes some movement before a swing will register. 

SLSHTHRESH – Slash threshold to determine the sensitivity of when a slash is registered. A slash is a fast/hard 

swing. Note that this setting takes effect after SWNGTHRESH, meaning it is impossible to set the values in such a 

way that it is impossible to register one or the other. 

MAXSWNG – Defines the maximum value that a swing will take. Higher numbers will give more variance to the 

dynamic range for the volume/pitch of swing sounds; lower values will make them all play at similar volumes. 

CLSHTHRESH – Clash threshold to determine the sensitivity of when a clash is registered. Zero (0) means hardly 

any impact will trigger it, 255 means a very hard whack is required. 

GYROXTHRESH – Only applicable when using a single button. This determines how hard of a twist is required 

before the motion is recognized by the system. Zero (0) means not much twist will be required; 255 means it 

requires a very hard force. 

GYROYZTHRESH – Only applicable when using a single button. This determines how much play in the other 

directions is allowed when registering a twist. The higher the value the more play is allowed, making the effect 

easier to perform. Note that this is the opposite as the other threshold values in which higher values make the 

effect more difficult to trigger. 

5.5.3. BLADE 

The most important function of this tab is to control the blade color for the main blade pulsing. 

It’s important to note how color editing works. First, in all my examples I assume BGR – that is the (royal) blue die 

is hooked to C1, the green die is hooked to C2, and the red die is hooked to C3. Following this, setting C1COLOR to 

255, C2COLOR to zero (0), and C3COLOR to zero (0) would be blue. Similarly, setting C1COLOR to zero (0), 

C2COLOR to 255, and C3COLOR to zero (0) would be green. 

To dial in a specific color with RGB, I recommend going to the online selector here: 

https://galactic.ink/sphere/ 

It helps choose colors and then gives the r,g,b representation of those colors. You can use the bottom 3 sliders to 

help select a color to input. Remember that you need to reverse the order as they use r,g,b not b,g,r. 

If you are using a TriCree with 2 or more die the same color, just always treat those two as the same value. For 

example, for a B,B,G die, you can set c1Color = 255 and c2Color = 255 to get the blue at full brightness. If you want 

a cyan color you might do C1COLOR = 80, C2COLOR = 80, and C3COLOR = 255. 

https://galactic.ink/sphere/
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If using an RGBW or RGBA in-hilt LED, or an RGBW SK6812 pixel strip, then set C4COLOR to represent the color for 

amber/white. For an in-hilt LED it is important to set the appropriate c4Percent value in the master as well; see 

more on the master settings in 5.5.1 MASTER. 

You can also use the simulator to see the color that is selected. Note that by default the program assumes BGR; 

this can be changed in the Options->Color Settings menu. Note that changing this will have NO effect on the actual 

colors that actually show up on the saber; rather, you set this to match the saber install. This is why I HIGHLY 

recommend installing BGR so that all the examples and colors line up to the defaults. 

The blade effects settings are also in this tab. They define the blade characters for the pulsing effects. Each setting 

is listed below with a description of how to use the parameter. 

 

Figure 22 – Screenshot of the Blade Effects tab. 

BLDEEFFECT – Defines the pulsing effect for the blade, choosing either a pulsing or flickering style. Use the 

simulator to get an idea of how the effect will look in the saber. 

INLEN – Length in milliseconds for the retraction effect. Choose zero (0) to have the effect match the length of the 

file. 
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OUTLEN – Length in milliseconds for the extension effect. Choose zero (0) to have the effect match the length of 

the file. 

New in R4 BLADESHADE – Defines the amount of variance in the blade color that is allowed when the saber starts, 

or when a new color-set is selected. Higher values allow more variance; lower values allow less. Recommended is 

8-16 for slight variance on the blade color. 

5.5.4. CLASH 

The clash tab contains the color settings for the clash color, along with specific settings for the clash effect. See 

5.5.3 BLADE for details on how to set a specific color, as setting the main blade and clash are the same. 

 

Figure 23 - Clash tab contains settings for the clash color and clash effects 

C1FLSHC, C2FLSHC, C3FLSHC – color parameters for the clash colors. Use these together to set the clash color. 

CLSHEFFECT – Defines the clash effect for the blade. Use the simulator to get an idea of how the effect will look in 

the saber. 

USE ALTERNATING CLASH (ACLSH) –When enabled, the clash will vary between the clash color and blade color 

for a more dramatic effect. 
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New in R4 DRAG COUNT – Enables the new drag feature and defines how many LEDs from the top will light up 

when doing the drag effect. Drag is initiated by holding the saber down and holding the aux button when running. 

Setting the value to zero (0) disables the feature so that the lockup is used even when holding the saber down. 

New in R4 CLASHSHADE – Defines the color variance for the clash effect. Higher values allow more variance in the 

color; lower values make it more static like the defined color. Recommended is sixteen (16) for clash. 

CLSHWAITLEN – Amount of time (in milliseconds) after a clash before a blast/clash/swing can interrupt. 

BLOCKLEN – Length of time (in milliseconds) to hold the button before it is registered as a lockup. 

 

5.5.5. BLAST 

The blast tab contains the color settings for the clash color, along with specific settings for the blast effect. See 

5.5.3 BLADE  for more details on how to set colors. 

 

Figure 24 – Screen shot of the blast settings in the NEC Editor. 

C1BLSTC, C2BLSTC, C3BLSTC – Use together to set the color during the blast effect. 
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BLSTLEN – Length (in milliseconds) for the blast effect to play. Setting to zero matches the length of the file. 

NIMPTBLAST –Applicable only when using a WS2812 (NeoPixel) blade. This setting defines the size for the Impact 

Blast™ feature. This value should be between 0 and half the length of the blade, as it defines where the impact 

range should occur from the middle. Setting to zero (0) will disable the feature. 

New in R4 BLASTSHADE – Defines the color variance for the blaster block effect. Higher values allow more 

variance in the color; lower values make it more static like the defined color. Recommend is twenty four (24) for 

blast. 

5.5.6. AUDIO 

The audio tab contains some settings directly related to the audio. These settings are described in detail below. 

 

Figure 25 – Screenshot of the Audio tab. 

LINEAR HUM/IN/OUT –Enable this setting to have the hum, extension, and retraction sounds play in order as they 

appear on disk instead of being random order. 

LINEAR ACTION –Enable this setting to have the swing, slash, clash, blast, and lockup sounds play in order instead 

of being randomly selected. 
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HUMSTART – Length in milliseconds in which the hum starts playing before the end of the extension sound. For 

example, if the extension sound is 1,000ms (1 second), and this is set to 400ms, then the extension will play 600ms 

before the hum starts. 

VOLHUM – Volume for the hum sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

VOLEFF – Volume for the effect sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

5.5.7. ACCENT 

Accent settings tab. Unlike Igniter™ which has complicated accent settings, Spark 3™ has simple drop-downs to run 

the accents. This allows for easy setup and ensures a nice pattern. 

To change the accent pattern for each mode, simply choose the pattern from the drop down for that mode. To see 

the pattern in the simulator, make sure that the desired mode is chosen from the Accent mode dropdown, which 

in the NEC Editor is right above the 8 accent LEDs, above the start and stop buttons for the accent portion of the 

simulator. 

 

Figure 26 – Screenshot of the Accent tab. Use the individual dropdowns to set each effect. The dropdown is used to indicate to the simulator 

which one should be running in the simulator for inspection. 
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5.6. GENERATE DUAL OUT SOUNDS FOR CROSS-SABER 

The best experience for Cross-Saber is to utilize the new dual out sounds, named DOUTNN.WAV, where NN is a 

number 01 to 99. Basically, these files would be a second extension mixed in the original at the delay of humStart 

in the config, which would make a second delayed sound when the second blades turn on. Creating these manually 

would be a tedious task. However, with the new Create Dual Out Wavs function in the config editor, it is a breeze. 

For each font you just open the font, go to Edit->Create Dual Out Wavs, and click. That’s it; one dual out wav will 

be created for each out wav for the font, with the secondary extension mixed at the delay of humStart set in the 

config. 

Once created, just save the font so the number is updated any the font will now use the dual out sounds if Cross-

Saber is enabled. Note that if there are no dual out sounds the normal out ones will be used so this is not a 

mandatory step, but does enhance the overall experience. 

5.7. FORMAT MICRO SD 

I no longer recommend using Windows built-in format tool to format the SD cards, as it doesn’t do a true UNIX 

style format. Instead, it is much better to use a good 3rd party tool, such as SDFormatter. 

https://www.sdcard.org/downloads/formatter_4/ 

This tool will properly format the SD card for use with all my boards. 

Upon launching the tool the window below will be shown 

 

https://www.sdcard.org/downloads/formatter_4/
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Figure 27 – Using SD Formatter to format the micro SD card for use with any of my products, including Spark™, Spark Color™, Igniter™, and 

Sound Hornet™. 

To format an SD card, simply select the drive of the micro SD card from the Select card dropdown, type a name 

into the Volume label field, ensure Quick Format is chosen, and hit format, clicking yes on the prompt that 

appears. This will format the card and erase the existing contents, ensuring it is ready for use with your board. 

Note that I do this for every card that gets sent with the board, but this is necessary for those that are changing 

fonts and/or have a new SD card. 

5.8. COPY FILES BACK TO THE MICRO SD 

To copy the files back, simply move all the files from the “c:\Spark\Saber1” directory to the root of the micro SD 

car. This will ensure that the files are written well and can be accessed quickly by Spark 3™. Once this step is done 

the micro SD card is ready to be loaded back on to Spark 3™ to enjoy the new settings and fonts! 

6. ERROR CODES 

Spark 3™ comes equipped with an on-board SMD error LED, which blinks to indicate certain SD or read failures, 

making install a snap. When an error occurs, the led will blink a certain number of times, and then will pause for 1 

second. Getting the number of blinks can then be used to determine the failure, by using the table below. 

The following table shows the number of blinks and which error it represents. Errors in red are fatal errors and the 

board will not be responsive until it is power cycled. 

Num of Blinks Error 

2 Bad card, empty card, not formatted 

3 DAT not found 

4 Boot wav not found 

5 Main wav read error 

6 Config file not found 

7 Effect wav not found 

8 Effect incorrect format 

9 SD card locked 

Table 2 – Error codes for the accent error LED. 
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7. SABER OPERATION 

To use your saber, with the micro SD card inserted and the wiring correctly completed, insert the battery or pull 

the kill key. You should hear the boot sound or first font sound play (depending on the config setting), and you 

should also see the first accent LED blinking rapidly. After this your saber will load into idle mode for the first font. 

There are three main modes of operation for the saber: Idle mode, Running mode and Tracks mode. These two 

modes will be discussed in detail in the next sections. 

7.1. IDLE MODE 

Idle mode is when the saber is loaded for a font but not running. This is where the accent LEDs are running the idle 

pattern, and the saber is ready for use. In this mode there are two ways to interact with the saber. The first is 

hitting the aux button to advance to the next font. When you are on font three, hitting aux goes back to font1. 

Spark™ always assumes that there are 3 fonts present on the config card, so make sure they are always present on 

the micro SD card. 

The other way to interact with the saber is by hitting the main button. This puts the saber in running mode. For 

more details on that see the next section. 

7.1.1. IDLE MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in idle mode. 

Entry Label Action Description 

Main button MAIN+/- Press/Latch Pressing the main button (latching when it is a latching switch) 
puts the saber into running mode for font1 and font2, and 
font 3; for saber tracks, it is used to engage the blade. 

Aux button AUX+/- Press Advances to the next font. 

Twist Hilt NA NA When One Button is set with motion in the master, twisting 
the hilt while in idle mode will advance to the next font. 

Table 3 – Possible interactions in idle mode, when the kill key is pulled but the saber is not in the hum effect. 

7.2. RUNNING MODE 

When the saber is running, there are many actions that are possible. Swings, Blaster Blocks, Clashes, Lockups and 

retraction all become available. Further, this is when the main LED runs and accent LEDs follow the patterns for the 

actions performed. A detailed description on how to interact with the saber is given in the following subsection. 

To stop the saber from running, simply hold down the main button (unlatch if it is a latching switch) until the 

retraction sound and effect happen. The saber will then return to Idle mode. From here you can re-insert the kill 

key or remove the battery. Do not remove power when the saber is running, as this can cause the micro SD card to 

get an incorrect formatting, and then it would need to be reformatted. Granted this is very rare but it is better to 

put the saber into Idle before disconnecting the power. 
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7.2.1. RUNNING MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in running mode. If the One Button 

is enabled in the config, please see the interaction guide for one button below. 

Entry Label Action Description 

Aux Button AUX +/- Press Pressing the aux button engages Blaster Block mode. Once in 
this mode, swinging the saber will perform EzBlaster™, where 
another Blaster Block will be performed. Keeping the saber 
still will cause the mode to exit. 

Aux Button AUX +/- Hold Holding the aux button engages the Lockup effect. Depending 
on the chosen config setting, either releasing the button or 
tapping it again will cause the mode to exit. 

Aux Button AUX +/- Press (in 
Clash) 

Pressing the AUX button will perform EzLockup™; 
immediately after the press the Lockup sound will play when 
in Clash mode. 

Aux Button + 
Clash 

AUX +/- Hold + Clash Pressing and holding the AUX button and performing the 
clash motion will perform the EzLockup™, skipping the clash 
sound and going right to the lockup with the clash color. 

Swing saber NA NA Swinging the saber causes a single swing sound to be played. 
If the swing is performed rapidly then a Slash sound will be 
performed. 

Hit saber/Blade CS NA Hitting the saber against something or hitting your hand on 
the hilt will cause the Clash sound to play. To return to 
running simply wait for the clash to finish. 

Main Button MAIN+/- Hold/Unlatch Holding or unlatching the main button will cause the 
retraction sound to play and then the saber will return to Idle 
mode. 

Table 4 – Interactions possible when the saber is running, and two buttons are installed. 

7.2.2. RUNNING INTERACTION FOR ONE BUTTON 

If the saber is configured to run with one button, the following is the interaction guide while operating the saber: 

Entry Label Action Description 

Main Button MAIN +/- Press Pressing the aux button engages Blaster Block mode. Once in 
this mode, swinging the saber will perform EzBlaster™, where 
another Blaster Block will be performed. Keeping the saber 
still will cause the mode to exit. 

Main Button AUX +/- Press (in 
Clash) 

Pressing the AUX button will perform EzClash™; immediately 
after the press the Lockup sound will play when in Clash 
mode. 

Swing saber NA NA Swinging the saber causes a single swing sound to be played. 
If the swing is performed rapidly then a Slash sound will be 
performed. 

Hit saber/Blade CS NA Hitting the saber against something or hitting your hand on 
the hilt will cause the Clash sound to play. To return to 
running simply wait for the clash to finish. 
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Main Button MAIN +/- Hold Holding or unlatching the main button will cause the 
retraction sound to play and then the saber will return to Idle 
mode. 

Main Button + 
Hit saber 

MAIN +/- Hold + Clash Holding the main button and then immediately performing 
the clash action while still holding the main button will 
perform the EzLockup™ feature, bypassing the clash and 
going right to the lockup. This ensures the clash will perform 
using the specified clash color. 

Table 5 – Interactions possible when the saber is running, and a single button is being utilized. 

7.3. SABER TRACKS 

The menu in Spark 3™ cycles through each of the 3 fonts, and then to the special Saber Tracks font, before cycling 

back to the first font. After hearing the “Saber Tracks” audio clip in the menu, you will immediately be entered into 

Saber Tracks™ mode and the first track will immediately start playing. In Spark 3™ all the TRACKNN.WAV files go in 

the /tracks folder right off the root of the micro SD card. 

New in R3 – Saber Tracks™ now has the ability to engage the blade while the music is playing! After hearing the 

music start, you can either press and hold the main button (if it is momentary) or latch the main button (if it is 

latching) to ignite the blade. The extension effect will occur followed by the pulsing of the blade. No additional 

effects will be displayed, and now sound effects will play, but the music will stream non-stop. 

The blade color and pulse for Saber Tracks™ in Spark 3™ will be selected from the last used font. This means that 

Saber Tracks can be used with any of the 3 blade colors for each of the 3 fonts. 

To turn off the blade, simply hold the main button (if it is momentary), or unlatch the main button (if it is latching). 

Holding the aux button or doing the twist motion for a single button install will exit Saber Tracks and load the first 

font. 

7.2.3. SABER TRACKS INTERACTIVITY 

The following table describes the interactivity for Saber Tracks. 

Entry Label Action Description 

Aux Button AUX +/- Press Advances to the next track. When the last track file is reached 
it goes back to the beginning. 

Main Button MAIN +/- Hold/Latch Holding or latching the main button will enable the blade, 
doing the extension effect first then the pulse effect. 

Main Button MAIN +/- Hold/Unlatch Holding or unlatching the main button will cause the blade to 
retract if the blade is current enabled. 

Aux Button AUX +/- Hold Holding the aux button will exit Saber Tracks™ and load the 
first font. 

Table 6 – Interactions possible when two buttons are installed and Saber Tracks is engaged. 

When One Button is enabled in the master section, the following defines the interaction 

Entry Label Action Description 
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Main Button MAIN +/- Press Advances to the next track. When the last track file is reached 
it goes back to the beginning. 

Main Button MAIN +/- Hold Holding the main button enables the blade, doing the 
extension effect first then the pulse effect. 

Main Button MAIN +/- Hold Holding the main button when the blade is enabled will do the 
retraction and turn off the blade. 

Twist NA Rotate Rotating the saber for a single button install will exit Saber 
Tracks™ for a single button installation. 

Table 7 – Interactions possible when a single button is installed and Saber Tracks is engaged. 
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